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FileView is a FREE program

File View

Check the Contents of a File

file:///D:/fileview.html

Software by Mike Robinson

. Donation of $10 is requested but not required. All features are enabled. No time limit. No advertising. No spyware. No nag

screens.
5 File View
File Options Actions Help About
Opens With: * Irfanview B4-bit (i_viewbd.exe) Get Extra Info Actions v Show Picture
‘D:\cat.jpg |
Select File 699,837 bytes Upper Case Digests View Digests Title [ value
CRC32 sHA 1 [E9E4ADSIFBCAE21AAIC01093732BCDEF3FAIIBEC | | Flefame cat.jpg
Bytes 699,837
SHA-256 [45E8 1E456ACA97BD3984043F5ACB2FD093D195F 2 11EGATF IBEB4080F66BF620 | | Date Created My SEptepber: 27, 202 CRTE s 37 PN
Date Modified Friday, November 18, 2011, 3:18:54PM
Hex Mode [ Filter Chars MD5 |3EF18233001B4211DF471C41A5023F3D l Date Accessed Monday, September 27, 2021, 1:20:02PM
Attributes N
FF D8 FF E1 38 45 49 49 2a + BSEExif..IIx. . FieType IrfanView JPG File
0PPOPP1A 08 0P 0P 0P BB 00 00 92 90 [...6.798. ...f.
0000 00 @0 OF 01 82 22 2 g :E : CRC 562A5C54
o 2i B2 U8 bl o SHA-1 ESE4AD53FBCAE21AA9C01093732BCDEF3F)
e L SHA-256 45E8 1E456ACAG97BD3984043F SACB2FD09:
v.0...8. .. 108, .. MD5 3EF 18238C0 164211DF471C41AB023F 3D
.268.9...00
5 . ic File Type PG Image File
0900PR90 B4 00 ¢.0....8..1v..0L Image Size 2048 x 1536 pixels
000000A0 :gg:s DIGITAL g: Image Description OLYMPUS DIGITAL CAMERA
5 Make OLYMPUS OPTICAL CO.,LTD
¥YMPUS OPTICAL CO Mad ]
..LTD.C3000Z. . . . ode 30002
. ..H...®...H. Orientation Normal
.u353u-73. XResolution 72.00
. YResolution 72.00
S 211z Resolution Unit Inch
9 6-97;1.Ue-§.@. Software v353u-73
- -“9;-;"'*-3- =98 pate Time 2011:11:18 09:06:07
9PABB150 i O e nia o Mooy YCb Cr Positioning Co-sited
00000160 o0 s EXif Offet 2
70 ..%€0.9...f0. .Ce Exposure Time 10/1000 sec
80 . 4. .COv.Bxt.0. FNumber F2.8
0PP0P199 00 08 7A 02 09 094 92 On 00 B1 00 00 00 82 B2 ..zO..¢fH.0...é0 Exposure Program Normal

p000B1AB B0 85 92 @85 90 61
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If you are in Windows Explorer just select the and right click and use the "Send To" and then select "FileView" as shown here:

File Edit View Tools Help

Folders
Bl Desktop

B user

. Public

18 Computer
<4 Floppy Disk Drive (A})
&, 80616 (C)

I, $Recycle.Bin

Name ~ Size

i photoLjpg
L4 phato2,jpg

ide Show

Date modified Type
189 KB 12/3/2006 9:05PM  JPG File
20 /2/2006.9-05 D106, File

Edit

Print

Preview

Cut
Copy

Delete

It pops up the information screen shown at the top of this page. It does this without leaving Windows Explorer.

Rename

Open With Documents

FileView

Send To »| P2

Compressed (zipped) Folder
Desktop (create shortcut)

Properties l

You can also run FileView as a stand-alone program from the FileView desktop shortcut. In this mode it pops up a menu to select the to view.

FileView can read the basic information such as size and date of any type. If you click the "Get Extra Info" checkbox the program will display all of the unique extra information in
the header for that particular type. It can read extra information for these types:

Shown Animated)
chive

(Compressed Archive)

GIF Image or Animated GIF Image

(including EXIF extended info)
(including EXIF extended info)

ANI -- Animated Cursor (
ARJ -- ARJ Compressed Ar
AVI -- AVI Video

BMP -- BMP Image

CAB -- Microsoft Cabinet
CUR -- Cursor Image

EXE -- Executable Program
GIF --

ICO -- Icon Image

JPG -- JPG Image

JPEG - JPG Image

MP3 -- MP3 Audio
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PCX -- PCX Image

PNG -- PNG Image

SCR -- Windows Screensaver
TTF -- TrueType Font

TXT -- Text

WAV -- WAV Audio

ZIP -- ZIP Compressed Archive

Image files are displayed on the far right if Show Picture box is checked. Animated GIF files are shown animated, such as this cheetah:

This is a 32 bit program and will run on Windows ME, NT, 2000, XP, Vista, Windows 7, 8, 10, and Windows 11. It also runs fine on 64-bit systems.

See the bottom of this page if you would like to donate $10.00 (Ten US Dollars). Donation is requested but not required. This free program is fully functional. No features have
been removed. No time limit. It contains no spyware, no advertising, no nag screens.

Windows Explorer Mode

The first time FileView runs it places a link to itself in your Windows "Send To" folder. Open Windows Explorer and navigate to the and then right click and select "Send To" menu
item then select "FileView" menu item. This sends the to FileView.

StandAlone Desktop Mode

Double-click on the FileView shortcut on the desktop and the program opens in StandAlone Mode. Click the "Select File" button and a window pops up to navigate to the files you
want to View. You can also View files using the "File" menu at the top of the screen.

Operations

Once you have selected a file, you can perform a number of different operations on the file.
These are available using the "Actions" main menu item:

- File View
File Options Actions Help About

Opens Wwith: 3§ * b
cat.jpg /- Properties l
Data to File... - - -
Select File [ Datato Clipboard [ Upper Case Digests View Digests
CRO (B Name to Clipboard SHA 1 ‘E9E4AD53FBCAE21AA9001093732E}CDEF3FA93BEC }
sHai [B) Fileto Clipboard 984043F5ACB2FD093D195F211E6A7F1BES4080F66BF620 |
y CopyfFile..
[ Hex M ) MD5 |3EF18238C0184211DF471C41ABUZ3F3D |
s~ View (Hex)
000000PA | X Open File Location 78 69 66 90 49 49 2A + BSEExif..II%. A
80000010 ) 02 90 20 90 00 00 92 00 [...6.708. ...f.
(51515150505 4%} B2 -
#00000830 12 B.e. . -
o1 . .0...902.0.. .
E@ .. eE2.0...a...(@
#0000060 31 -]
0P0PE070 14
ABRRRA8A 82
80000090 18 .-
51515151515 3]% ) 54 YMPUS DIGITAL CA

ABRARABA
P0ABACH

MERA OL

YMPUS OPTICAL CO

Or use the identical "Actions" button drop-down menu:

Get Extra Info Actions v Show Picture
# Open {
Title -/ Properties | A
FileName k3 DatatoFile...
Bytes o= .
Date Created Data to Clipboard 6:03:46 PM
Date Modified [ Nameto Clipboard 18:54 PM
Datg Accessed IE File to Clipboard 10:05:47 AM
Attributes > i
File Type 5;] Copy File...
= J- View (Hex)
SHA-1 @ OpenFileLocation  booceeaianeec
SHA-256 45E8 1E456ACA697BD3984043F SACB2FD093D 195F 211E6A 7F 1BE84080F66BF620
MD5 3EF18238C01684211DF471C41AB023F3D
File Type JPG Image File
Image Size 2048 x 1536 pixels
Image Description OLYMPUS DIGITAL CAMERA
Make OLYMPUS OPTICAL CO.,LTD
Model C3000Z

Open - Opens the using the default program defined in your Windows setup for this type. For example, if it is a Microsoft PowerPoint it will open PowerPoint and show the file.

Properties - Opens the standard Microsoft properties screen for the file. This is the same screen you see in Windows Explorer if you right click on a and select properties. This
screen allows you to change the attributes of the such as "Read-only" and "Hidden" attributes. If also shows the Digital Signatures if the has been signed.
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%

General Digital Signatures  Security Details  Previous Versions

*

Type of file:

Opens with

Location:
Size:

Size on disk:

Created:
Modiffied:
Accessed:

Attributes:

ICE‘-JDQ

IfanView JPG File (jpg)
M IfanView 64bit

CAHOM
683 KB (699,837 bytes)
684 KB (700.416 bytes)

Change...

Tuesday, September 28, 2021, 10:51:17 AM

Friday, November 18, 2011, 3:18:54 PM

Today, September 28, 2021, 10:51:17 AM

[JRead-only []Hidden

OK Cancel

Advanced...

Apply

Data to File - Allows you to save all of the information to a text that looks like this:

This File Created: Tuesday September 28, 2021 at 12:26:00 PM

File Name

Bytes

Date Created
Date Modified
Date Accessed

Attributes ......... ..l
I I Y
ERE, =i e
Ly ' T S - e s
SHA-256 tivviiinnnnnnnnnnnn
MD5 Sseseteleiineesenesiosass
File Type tiviriiiinnnnnnnns
Image Size .ivvvvnvnnnnnnnn
Image Description .........
Make ..iviiiiiiiiiiiiiina.,
Model .....oivivniininnnn..

cat.jpg
699,837

Monday, September 27, 2021,
Friday, November 18, 2011,

Tuesday, September 28, 2021,
- = = A= = = = =

IrfanView JPG File

562A5C54

6:03:46 PM
3:18:54 PM
12:25:45 PM

E9E4AD53FBCAE21AASC01093732BCDEF3FA93BEC

45E81E456ACA697BD3984043F5ACB2FDO93D195F21

3EF18238C01B4211DF471C41AB023F3D

JPG Image File

2048 x 1536 pixels
OLYMPUS DIGITAL CAMERA
OLYMPUS OPTICAL CO.,LTD
C30007Z

Data to Clipboard - Sends all of the information shown above to the Windows clipboard.

Name to Clipboard - Sends the full path and name to the Windows clipboard.

File to Clipboard - Sends the entire file to the Windows clipboard.

Copy File - Allows you to make a copy of the in a folder.

View (Hex) - Opens the Viewer to examine the detailed contents inside the file:

pe

File Edit Search Options Help Close

catjpg
ABAEN0A 78 69 66 B0 B0 49 49 2A B T BSEExif..IIx. A
ABRNRA10 91 92 00 20 00 PO 00 92 08 Q..
A0ARBA20 90 0@ G0 B2 0@ 00 9O 10 @1
#BRBRA30 90 00 90 12 61 @3 00 61 00 ... .0.
#BRARA40 91 95 00 01 60 PO 06 D8 B8 ..O...»E2.0...F.
A0ARBAS0 90 00 0P EO 00 00 00 28 B1 ..<E2.0...x...<Q
ABRBRB6H0 90 60 90 31 61 B2 90 6% 00 ¢.0...8...168...
#BRARA7A 91 92 00 14 60 60 66 @8 A1 ..3...268.9...00
ABAREASA 90 00 60 B2 00 B0 PO 6% 87 ..!'@v.0...8...i¢
ABRARA%0 91 00 90 18 @3 9O BB 4F 4C ¢.0...-6..1v..0L
ABABAAAB 49 47 49 54 41 4C 20 43 41 YMPUS DIGITAL CA
#BPBROBA 20 20 20 20 20 20 B8 4F 4C MERA .OL
ABRARACH 50 54 49 43 41 4C 20 43 4F YMPUS OPTICAL CO
ABAABADA 33 30 30 30 5A 00 90 6@ @@ ..LTD.C300QZ....
PBRBROEA 90 01 90 PO B0 48 V0 B0 @@ ....H...G...H...
ABRABAFA 33 75 2D 37 33 60 90 6@ B0 ©...v353u-73....
00PP0100 0P BP PO 0P GO PO 0P PO PO 0P PO OO 0P BB B0 B ................ v

< >

Line: 0 Col: 0 Lines: 43,740 Bytes: 699,837

file:///D:/fileview.html

The Hex (hexadecimal) view is show above. Using the "Options" menu item on the top you can change the view to Hex Filtered Mode that filters out all of the non-text characters,
or Text Mode that shows the as if it were all text.

On the first line of the above you can see the text "Exif" that means the contains extended Exif information typical of JPG files produced by digital cameras. This Exif info often

contains much additional information such as the camera model, exposure settings, and date the photo was taken.
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Using the menu at the top of the viewer you can also search for text, go to a line number, copy some or all of the contents, or change the character font of the display. All of these
functions are read-only so the contents of the will not be changed.

Get Extra Info Checkbox

If you check this box, you will get all of the available information. If you do not check this box, you will get just the basic information: name, size, date/time (modified, created,
accessed), attributes, and type.

The extra info includes a value called the CRC32 (Cyclic Redundancy Check). This is an 8 digit hexadecimal value that is unique to that particular file. If just one byte in the is
changed the CRC will change. This is a good way to detect tampering. If you look inside of a ZIP compressed archive you will see that the ZIP program saves the CRC of each in
the ZIP so that it can be sure the has not been altered.

In order to compute the CRC the program must read the entire file. If this takes too long for a large you may want to uncheck the "Get Extra Info" checkbox.

Show Picture Checkbox

If you check this box, and the is an image file, a small copy of the image will be shown on the right. If you click on the image, a window will open with a full-size view of the image.
View Digests Button

Digests are Cryptographic Hash Functions named SHA-1, SHA-256, and MD5. These are the calculated strings of letters and numbers that are unique to that file. Theoretically, no
two files can have the same digest. If the digest of a has not changed, that is good evidence that the has not been altered.

To check a digest, copy the expected digest text to the Windows Clipboard. Then press this button, and the value in the clipboard will be compared to all of the digests, and will
show a match if it exists.

Options Menu

The options menu contains the following options:

Save on Exit - Check this menu item and the current settings will be saved and remembered the next time you run the program.

Stay on Top - Check this menu item and FileView will stay on top of your other windows.

Install

The first time you run FileView it will automatically put a shortcut to itself in your SendTo folder.

As an Administrator run the program fileview-setup.exe to install the program. The install program will overwrite any previous version so you are not required to uninstall older
versions. The install program will create a folder, copy all the files to the folder, and create shortcuts on the desktop and the start menu. This is a 32-bit program designed for

Windows 98, ME, 2000, NT, XP, Vista, Windows 7, 8, 10, and Windows 11, It also runs fine on 64-bit systems. The program saves its settings in the Windows Registry when you
exit from the program.

An alternate install method is to download the executable fileview.exe and then just run the program. You can create your own Desktop Shortcut or other shortcut links.

Uninstall

Open Windows Control Panel, select Programs and Features, select the program in the list of programs, and click the uninstall button, or right click on the program and select
Uninstall in the menu. The Windows uninstall system will then run and remove the program. These steps are for Windows 10 and Windows 11 and may be slightly different in
other Windows versions.

If you installed the program manually then delete the files to uninstall the program, and also delete any Desktop Shortcut or other shortcut links.

Then delete this entire key in the Windows Registry :

HKEY_CURRENT_USER\SOFTWARE\Michael_Robinson\FileView

Saved Settings

When the program closes it remembers all of its settings by saving them in the Windows registry. It saves the size and location of the program on your desktop, Get Extra Info
checkbox, Stay on Top setting, Save on Exit setting, viewer hex/text mode, and viewer filter setting. The next time you use the program it will open the same folder used in the last
view.

Support

Send your questions and comments to: ElegantPie@HotMail.com

| fully support this program and will usually answer within 24 hours.

The latest version is always available on my Home Page:

https://elegantpie.com

Legal Stuff

This program is Copyright © 2021 Michael Robinson. All Rights Reserved. Use this program at your own risk. You may give this away free, but you may not sell it. It must be
distributed as a package along with all files. Modification of the files is prohibited.

Revision History

1.0.0 Oct 6, 2021 Initial Public Release

Digital Signature

| purchased a Code Signing Certificate from Certificate Authority (CA) company Sectigo and used it to digitally sign (and timestamp) program executable fileview.exe and install

program fileview-setup.exe. The signature says it was signed by MICHAEL ROBINSON. Code Signing proves that the program actually came from me and has not been modified
by a hacker since it was signed.

Run Windows Explorer (explorer.exe) right click on the and select Properties:
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Name

£ weath scr
View >
Sort by >
Group by >
Refresh

Customize this folder...

Paste
Paste shortcut

Undo Move Ctrl+Z
Give access to >

(5] Shared Folder Synchronization >
New >
Properties

Then click on the tab Digital Signatures, and click the Details button:

VERIFY
&
General Digtal Signatures  Securty Detais Previous Versions
Signature list
Name of signer: Di Timestamp
MICHAEL ROBINSON shal Wednesday, August 4, 2021 1:58:..
< >
Details Signing time: |Wednesday, August 4, 2021 1:58:06 PM
View Certificate
Countersignatures
Name of signer: Timestamp
Sectigo RSA Time Stamping Signer #2  Wednesday, August ...
OK Cancel Apply

Then click the View Certificate button to see my certificate:

| Certificate

General Details Certification Path

La Certificate Information

This certificate is i for the following pur (s):
* Ensures software came from software publisher
* Protects software from alteration after publication

*Refer to the certification authority's statement for details.

Issued to: MICHAEL ROBINSON

Issued by: Sectigo Public Code Signing CA R36

Valid from 8/3/2021 to 8/4/2022

Install Certificate... | | Issuer Statement

If even one byte is changed, either in the or in the signature, the signature will show as invalid in the properties.

Donate

This FREE program is fully functional. Donation of $10 is requested but not required. All features are enabled. No time limit. No advertising. No spyware. No nag screens.
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The requested donation is $10.00 US Dollars. | accept major credit cards, PayPal , or personal checks. Press one of the links below and your browser will open and go to PayPal
with all the purchase information already filled out. You can use PayPal to pay by credit card even if you do not have a PayPal account. The total cost to you is $10.00. No fees.
Use your Visa, Mastercard, American Express, or Discover card. PayPal also allows you to pay directly from your bank account. PayPal is a very secure and reliable payment
system used by millions of people around the world.

E m‘?,'(' Use your Credit Card.

Or send payment by PayPal payable to: elegantpie@hotmail.com

Or send personal check or money order payable to Michael Robinson

Michael Robinson
PO Box 95
Shelton, CT 06484

PayPaI | am PayPal Verified. My Account Creation Date is May 30, 2000. Yes, | have been using this PayPal account for over TWENTY years.
VERIFIED

The Official PayPal Verified Seal above means that | have provided PayPal with proof that | have a bank account and that my address is valid. Banks are required by law to
screen account holders so PayPal's verification process increases security when you pay parties you do not know. My bank has my address and Social Security number on file. |
have been using PayPal for over 20 years.

| use PayPal because the fees are low. If you send me $10.00 PayPal only takes about $0.59 so | net $9.41. All other payment services take several dollars so | would have to
charge around $15 for my program to gain the same net. This lowers the cost to you. PayPal does not charge you any fees. PayPal is also free for me for most purchases, such
as Ebay auction payments, but as a seller | am required to have a Premier Account with fees. If you do not have a PayPal account, you can still use PayPal to make a payment
using your credit card. PayPal does not charge you any fees for this. PayPal is a very secure and reliable payment system used by millions of people around the world.

DOWNLOAD DONATE HOME EMAIL

elegantpie@hotmail.com

https://elegantpie.com

\ | Google Search |

only elegantpie.com
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